Dynamics and Vibrations
MATLAB tutorial

School of Engineering
Brown University

This tutorial is intended to provide a crash-course on using a small subset of the features of MATLAB. If
you complete the tutorial, you will be able to use MATLAB to integrate equations of motion for
dynamical systems, plot the results, and use MATLAB optimizers and solvers to make design decisions.

You can work step-by-step through this tutorial, or if you prefer, you can brush up on topics from the list
below.

If you are working through the tutorial for the first time, you should complete sections 1-13.6. You can
do the other sections later, when they are needed. If you have taken EN30, you should be familiar with
the material in Sections 1-10: you can review these if you like, or skip directly to Section 11. If you took
ENGNO0031, you can most likely start with Section 13.

1. What is MATLAB
2. Starting MATLAB
3. Basic MATLAB windows
4. Simple calculations using MATLAB
5. MATLAB help
6. Errors associated with floating point arithmetic (and an example of a basic loop)
7. Vectors in MATLAB
7.1 Creating Vectors with a Loop
7.2 Dot notation for operations on vectors
7.3 Operations on vectors using a loop
8. Matrices in MATLAB
9. Plotting and graphics in MATLAB
10. Working with M-files
11. MATLAB Functions
12. Organizing complex calculations as functions in an M-file
13. Solving ordinary differential equations (ODES) using MATLAB
13.1 What is a differential equation?
13.2 Solving a basic differential equation
13.3 Solving a basic differential equation in an M-file
13.4 Solving a differential equation with adjustable parameters
13.5 Common errors
13.6 Solving simultaneous differential equations
13.7 Controlling the accuracy of solutions to differential equations
13.8 Looking for special events in a solution
13.9 How the ODE solver works
13.10 Other MATLAB differential equation solvers
14. Using MATLAB solvers and optimizers to make design decisions
14.1 Using fzero to solve equations
14.2 Simple unconstrained optimization problem
14.3 Optimizing with constraints
15. Reading and writing data to/from files
16. Movies and animation




1. What is MATLAB?

You can think of MATLAB as a sort of graphing calculator on steroids — it is designed to help you
manipulate very large sets of numbers quickly and with minimal programming. MATLAB is particularly
good at doing matrix operations (this is the origin of its name). It is also capable of doing symbolic
computations (see the mupad tutorial for details).

2. Starting MATLAB

MATLARB is installed on the engineering instructional facility. You can find it in the Start>Programs
menu. You can also install MATLAB on your own computer. This is a somewhat involved process — you
need to first register your name at mathworks, then wait until they create an account for you there, then
download MATLAB and activate it Detailed instructions can be found at
http://www.brown.edu/information-technology/knowledge-base/article/1635

The instructions tell you to wait for an email from mathworks, but they don’t always send one. Just check
your account — if the download button for MATLAB appears you are all set. If you have previously
registered, you can download upgraded versions of MATLAB whenever you like. The latest release is
2016b, and you should download this version, as there are some small but important differences in the
ODE solver in earlier versions.

3. Basic MATLAB windows

Install and start MATLAB. You should see the GUI shown below. The various windows may be
positioned differently on your version of MATLAB - they are ‘drag and drop’ windows. You may also
see a slightly different looking GUI if you are using an older version of MATLAB.
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4. Simple calculations using MATLAB

You can use MATLAB as a calculator. Try this for yourself, by typing the following into the command
window. Press ‘enter’ at the end of each line.

>>x=4

>>y=x"2

>>z=factorial(y)

>>w=log(z)*1.e-05

>> format long

>>W

>> format long eng

>>W

>> format short

>>W

>>sin(pi)

MATLAB will display the solution to each step of the calculation just below the command. Do you notice
anything strange about the solution given to the last step?

Once you have assigned a value to a variable, MATLAB remembers it forever. To remove a value from a
variable you can use the “clear’ statement - try

>>clear a

>>a

If you type ‘clear’ and omit the variable, then everything gets cleared. Don’t do that now — but it is
useful when you want to start a fresh calculation.

MATLAB can handle complex numbers. Try the following
>>7 =X +i*y
>>real(z)
>>imag(z)
>>conj(z)
>>angle(z)
>>abs(z)

You can even do things like
>> log(z)
>> sqrt(-1)
>> log(-1)

Notice that:

e Unlike MAPLE, Java, or C, you don’t need to type a semicolon at the end of the line (To properly
express your feelings about this, type >>load handel and then >> sound(y,Fs) in the command
window).

e If you do put a semicolon, the operation will be completed but MATLAB will not print the result.
This can be useful when you want to do a sequence of calculations.

e Special numbers, like “pi’ and ‘i’ don’t need to be capitalized. But beware — you often use i as a
counter in loops — and then the complex number i gets re-assigned as a number. You can also do
dumb things like pi=3.2 (You may know that in 1897 a bill was submitted to the Indiana



legislature to declare pi=3.2 but fortunately the bill did not pass). You can reset these special
variables to their proper definitions by using clear i or clear pi

e The Command History window keeps track of everything you have typed. You can double left
click on a line in the Command history window to repeat it, or right click it to see a list of other
options.

e The output in the command window looks like crap. MATLAB is not really supposed to be used
like this. We will discuss a better approach later.

e If you screw up early on in a sequence of calculations, there is no quick way to fix your error,
other than to type in the sequence of commands again. You can use the ‘up arrow’ key to scroll
back through a sequence of commands. Again, there is a better way to use MATLAB that gets
around this problem.

e If you are really embarrassed by what you typed, you can right click the command window and
delete everything (but this will not reset variables). You can also delete lines from the Command
history, by right clicking the line and selecting Delete Selection. Or you can delete the entire
Command History.

e You can get help on MATLAB functions by highlighting the function, then right clicking the line
and selecting Help on Selection. Try this for the sqrt(-1) line.

5. MATLAB help

Help is available through the online manual — Click on the question-mark in the strip near the top right of
the window). The matlab manuals are also online, and will come up in google search.
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If you already know the name of the MATLAB function you want to use the help manual is quite good —
you can just enter the name of the function in the search, and a page with a good number of examples
usually comes up. It is more challenging to find out how to do something, but most of the functions you
need can be found by clicking on the MATLAB link on the main page and then following the menus that
come up on subsequent pages.



6. Errors associated with floating point arithmetic (and a basic loop)

If you have not already done so, use MATLAB to calculate
>>sin(pi)

The answer, of course, should be zero, but MATLAB returns a small, but finite, number. This is because
MATLAB (and any other program) stores floating point numbers as sequences of binary digits with a
finite length. Obviously, it is impossible to store the exact value of 7z in this way.

More surprisingly, perhaps, it is not possible even to store a simple decimal number like 0.1 as a finite
number of binary digits. Try typing the following simple MATLAB program into the command window

>>a=0;

>>forn=1:10 a=a+0.1; end

>>a

>>a-1
Here, the line that reads “for n=1:10 a=a + 0.1; end” is called a “loop.” This is a very common operation
in most computer programs. It can be interpreted as the command: “for each of the discrete values of the
integer variable n between 1 and 10 (inclusive), calculate the variable “a” by adding +0.1 to the previous
value of “a” The loop starts with the value n=1 and ends with n=10. Loops can be used to repeat
calculations many times — we will see lots more examples in later parts of the tutorial.

Thus, the for... end loop therefore adds 0.1 to the variable a ten times. It gives an answer that is
approximately 1. But when you compute a-1, you don’t end up with zero.

Of course -1.1102e-016 is not a big error compared to 1, and this kind of accuracy is good enough for
government work.  But if someone subtracted 1.1102e-016 from your bank account every time a
financial transaction occurred around the world, you would burn up your bank account pretty fast.
Perhaps even faster than you do by paying your tuition bills.

You can minimize errors caused by floating point arithmetic by careful programming, but you can’t
eliminate them altogether. As a user of MATLAB they are mostly out of your control, but you need to
know that they exist, and try to check the accuracy of your computations as carefully as possible.

7. Vectors in MATLAB

MATLAB can do all vector operations completely painlessly. Try the following commands
>>a =[6,3,4]
>>a(l)
>>a(2)
>> a(3)
>>p =[3,1,-6]
>>c=a+b
>> ¢ = dot(a,b)
>> ¢ = cross(a,b)
Calculate the magnitude of ¢ (you should be able to do this with a dot product. MATLAB also has a
built-in function called “norm’ that calculates the magnitude of a vector)



A vector in MATLAB need not be three dimensional. For example, try
>>a=[9,8,7,6,5,4,3,2,1]
>>b =[1,2,3,4,5,6,7,8,9]

You can add, subtract, and evaluate the dot product of vectors that are not 3D, but you can’t take a cross
product. Try the following

>>a+bh

>> dot(a,b)

>>cross(a,b)

In MATLAB, vectors can be stored as either a row of numbers, or a column of numbers. So you could
also enter the vector a as

>>a = [9;8,7,6;5;4;3;2;1]
to produce a column vector.

You can turn a row vector into a column vector, and vice-versa by
>> b = transpose(b)

7.1 Creating vectors with a loop

You can create a vector containing regularly spaced data points very quickly with a loop. Try

>> for i=1:11
v(i)=0.1*(i-1);
end

>> v

The for...end loop repeats the calculation with each value of i from 1 to 11. Here, the “counter”
variable i now is used to refer to the i entry in the vector v, and also is used in the formula itself.

As another example, suppose you want to create a vector v of 101 equally spaced points, starting at 3 and
ending at 2*pi, you would use

>> for i=1:101
v(i)= 3 + (2*pi-3)*(i-1)/100;
end

>> v

7.2 Dot notation for operations on vectors

You can often manipulate the numbers in a vector using simple MATLAB commands. For example, if
you type

>> sin(v)
MATLAB will compute the sin of every number stored in the vector v and return the result as another
vector. This is useful for plots — see section 11.

You have to be careful to distinguish between operations on a vector (or matrix, see later) and operations
on the components of the vector. For example, try typing
>> yA2
This will cause MATLAB to bomb, because the square of a row vector is not defined. But you can type
>>y.N2
(there is a period after the v, and no space). This squares every element within v.



You can also do things like
>>v. [(1+v)
(see if you can work out what this does).

7.3 Operations on vectors using a loop

I personally avoid using the dot notation — mostly because it makes code hard to read. Instead, | generally
do operations on vector elements using loops. For example, instead of writing w = v.”2, | would use
>> for i=1:length(v)
w(i) = v(i)"2;
end
>> W
Here, ‘for i=1:length(v)’ repeats the calculation for every element in the vector v. The function
length(vector) determines how many components the vector v has (101 in this case).

Using loops is not elegant programming, and slows down MATLAB. Purists (like CS40 TAs) object to it.
But | don’t care. For any seriously computationally intensive calculations | would use a programming
language like C or Fortran95, not MATLAB. Programming languages like Java, C++, or Python are
better if you need to work with complicated data structures.

8. Matrices in MATLAB

Hopefully you know what a matrix is...  If not, it doesn’t matter - for now, it is enough to know that a
matrix is a set of numbers, arranged in rows and columns, as shown below
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A matrix need not necessarily have the same numbers of rows as columns, but most of the matrices we
will encounter in this course do. A matrix of this kind is called square. (My generation used to call our
professors and parents square too, but with hindsight it is hard to see why. ‘Lumpy’ would have been
more accurate).

You can create a matrix in MATLAB by entering the numbers one row at a time, separated by
semicolons, as follows
>> A =[1,5,0,2;54,6,6;3,3,0,59,2,8,7]

You can extract the numbers from the matrix using the convention A(row #, col #). Try
>>A(1,3)
>>A(3,1)



You can also assign values of individual array elements
>>A(1,3)=1000

You can also use loops to create matrices
>> fori=1:4 for j=1:4 A(i,j) = i+j; end; end;
>>SA

This assigns the value i+j to the array element A(i,j). You could replace the ‘i+j’ to be any function of i
and j to define more complicated matrices.

There are some short-cuts for creating special matrices. Try the following
>>B = ones(1,4)
>>C = pascal(6)
>>D = eye(4,4)
>>E = zeros(3,3)

The ‘eye’ command creates the ‘identity matrix’ — this is the matrix version of the number 1. You can
use

>> help pascal

to find out what pascal does.

MATLAB can help you do all sorts of things to matrices, if you are the sort of person that enjoys doing
things to matrices. For example
1. You can flip rows and columns with >> B = transpose(A)
2. You can add matrices (provided they have the same number of rows and columns >> C=A+B
Try also >> C — transpose(C)
A matrix that is equal to its transpose is called symmetric
3. You can multiply matrices — this is a rather complicated operation, which will be discussed in
more detail elsewhere. But in MATLAB you need only to type >>D=A*B to find the product of
A and B. Also try the following
>> E=A*B-B*A
>> F=eye(4,4)*A-A
4. You can do titillating things like calculate the determinant of a matrix; the inverse of a matrix, the
eigenvalues and eigenvectors of a matrix. If you want to try these things
>> det(A)
>> inv(A)
>> eig(A)
>> [W,D] = eig(A)
You can find out more about these functions, and also get a full list of MATLAB matrix
operations in Linear Algebra page of the help menu.
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MATLAB can also calculate the product of a matrix and a vector. This operation is used very frequently
in engineering calculations. For example, you can multiply a 3D column vector by a matrix with 3 rows
and 3 columns, as follows

>>v = [4;3;6]

>>A =[3,1,9;2,10,4;6,8,2]

>>W=A*vV
The result is a 3D column vector. Notice that you can’t multiply a 3D row vector by a 3x3 matrix. Try
this

>>v = [4,3,6]

>>SW=A*V

If you accidentally enter a vector as a row, you can convert it into a column vector by using
>>V = transpose(V)

MATLAB is also very good at solving systems of linear equations. For example, consider the equations
3% +4Xo +TX3=6
5% +2Xy —9x3 =1
—X +13X, +3X3 =8

This system of equations can be expressed in matrix form as

Ax=D
3 4 7 X

A=|5 2 -9 X=X b=|1
-1 13 3 X3

To solve these in MATLAB, you would simply type

>>A=[3,4,75,2,-9;-1,13,3]

>> b =[6;1;8]

>>x =A\b

(note the forward-slash, not the back-slash or divide sign) You can check your answer by calculating
>> A*X

The notation here is supposed to tell you that x is b “divided’ by A — although “division’ by a matrix has
to be interpreted rather carefully. Try also



>>x=transpose(b)/A

The notation transpose(b)/A solves the equations XA =b, where x and b are row vectors. Again, you can
check this with

>>X*A

(The answer should equal b, (as a row vector) of course)

MATLAB can quickly solve huge systems of equations, which makes it useful for many engineering
calculations. The feature has to be used carefully because systems of equations may not have a solution,
or may have many solutions — MATLAB has procedures for dealing with both these situations but if you
don’t know what it’s doing you can get yourself into trouble. For more info on linear equations check the
section of the manual below
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9. Plotting and graphics in MATLAB This is an important section of this tutorial
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>> for i=1:101 x(i)=2*pi*(i-1)/100; end
>>y =sin(x)
>> plot(x,y)

1

05}
MATLAB should produce something that looks
like this (the 2014b MATLAB version produces
curves with a different color scheme and line
thickness to 2012b)

MATLAB lets you edit and annotate a graph
directly from the window. For example, you can -1 :
go to Tools> Edit Plot, then double-click the plot.

A menu should open up that will allow you to add



x and y axis labels, change the range of the x-y axes; add a title to the plot, and so on.

You can change axis label fonts, the line thickness and color, the background, and so on — usually by
double-clicking what you want to change and then using the pop-up editor. You can export figures in
many different formats from the File> Save As menu — and you can also print your plot directly. Play
with the figure for yourself to see what you can do.

. My first MATLAB plot
Helpful Hint: If you annotate a plot by hand, you . ; ;

can make MATLAB generate the code to re-create
your annotated plot automatically by going to File>
Generate Code. This is useful when you write your
own scripts and want to label plots automatically.

I have committed a sin

sin(t)

To plot multiple lines on the same plot you can use

>>y =sin(x) o.- T N N

>> plot(x,y) ' : : 5

>> hold on

>>y = sin(2*x) 1 : . 3 : : :
>> plot(x,y) ¢

Alternatively, you can use

>>y(1,:) =sin(x);

>>y(2,:) = sin(2*x);

>>y(3,:) =sin(3*x);

>> plot(x,y)

Here, y is a matrix. The notation y(1,:) fills the first row of y, y(2,:) fills the second, and so on. The
colon : ensures that the number of columns is equal to the number of terms in the vector x. If you prefer,
you could accomplish the same calculation in a loop:

>> for i=1:length(x) y(1,i) = sin(x(i)); y(2,i) = sin(2*x(i)); y(3,i) = sin(3*x(i)); end

>> plot(x,y)

Notice that when you make a new plot, it always wipes out the old one. If you want to create a new plot
without over-writing old ones, you can use

>> figure

>> plot(x,y)

The “figure’ command will open a new window and will assign a new number to it (in this case, figure 2).
If you want to go back and re-plot an earlier figure you can use

>> figure(1)

>> plot(x.y)

If you like, you can display multiple plots in the same figure, by typing

>> newaxes = axes;

>> plot(x,y)

The new plot appears over the top of the old one, but you can drag it away by clicking on the arrow tool
and then clicking on any axis or border of new plot. You can also re-size the plots in the figure window
to display them side by side. The statement ‘newaxes = axes’ gives a name (or ‘handle’) to the new axes,
S0 you can select them again later. For example, if you were to create a third set of axes

>> yetmoreaxes = axes;

>> plot(x,y)

you can then go back and re-plot “newaxes’ by typing

>> axes(newaxes);



>> plot(x,y)

Doing parametric plots is easy. For example, try
>> for i=1:101 t(i) = 2*pi*(i-1)/100; end

>> x = sin(t);
>>y = cos(t);
>> plot(x,y)

MATLAB has vast numbers of different 2D and 3D plots. For example, to draw a filled contour plot of
the function z =sin(2zx)sin(2zy) for 0<x<1, 0<y<1, you can use

>> for i =1:51 x(i) = (i-1)/50; y(i)=x(i); end

>> 7 = transpose(sin(2*pi*y))*sin(2*pi*x);

>> figure

>> contourf(x,y,z)

The first two lines of this sequence should be familiar: they create row vectors of equally spaced points.
The third needs some explanation — this operation constructs a matrix z, whose rows and columns satisfy
z(i,j) = sin(2*pi*y(i)) * sin(2*pi*x(j)) for each value of x(i) and y(j).

If you like, you can change the number of contour levels

>>contourf(x,y,z,15)

You can also plot this data as a 3D surface using
>> surface(x,y,z)

The result will look a bit strange, but you can click on the ‘rotation 3D’ button (the little box with a
circular arrow around it ) near the top of the figure window, and then rotate the view in the figure with
your mouse to make it look more sensible.

You can find out more about the different kinds of MATLAB plots in the section of the manual shown
below (or just google matlab plotting)
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10. Working with M files

So far, we’ve run MATLAB by typing into the command window. This is OK for simple calculations,
but it is usually better to type the list of commands you plan to execute into a file (called an M-file), and
then tell MATLAB to run all the commands together. One benefit of doing this is that you can fix errors
easily by editing and re-evaluating the file. But more importantly, you can use M-files to write simple
programs and functions using MATLAB.

To create an M-file, simply press the ‘New Script’ button on the main MATLAB window.
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This will open a new window for the matlab script editor, as shown below
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for i=1:101
theta (i} = -pi + 2Z*pi*(i-1)/100;
rho(i) = 2*=in(S*theta(i)):

end

figure
polar (theta, rho)
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Now, type the following lines into the editor (see the screenshot):
for 1=1:101
theta(i) = -pi + 2*pi*(i-1)/100;
rho(i) = 2*sin(6*theta(i));
end
figure
polar(theta,rho)



You can make MATLAB execute these statements by:

1. Pressing the green arrow labeled ‘Run’ near the top of the editor window — this will first save the
file (MATLAB will prompt you for a file name — save the script in a file called myscript.m), and
will then execute the file.

2. You can save the file yourself (e.g. in a file called myscript.m). You can then run the script from
the command window, by typing

>> myscript

You don’t have to use the MATLAB editor to create M-files — any text editor will work. As long as you
save the file in plain text (ascii) format in a file with a .m extension, MATLAB will be able to find and
execute the file. To do this, you must open the directory containing the file with MATLAB (e.g. by
entering the path in the field at the top of the window). Then, typing

>> filename

in the command window will execute the file. Usually it’s more convenient to use the MATLAB editor -
but if you happen to be stuck somewhere without access to MATLAB this is a useful alternative. (Then
again, this means you can’t use lack of access to MATLAB to avoid doing homework, so maybe there is a
down-side)

11. MATLAB functions This is an important section of this tutorial

You can also use M-files to define new MATLAB functions — these are programs that can accept user-
defined data and use it to produce a new result. For example, to create a function that computes the
magnitude of a vector:
1. Open a new M-file with the editor (press the ‘New’ button on the editor)
2. Type the following into the M-file
function y = magnitude(v)
% Function to compute the magnitude of a vector
y = sqrt(dot(v,Vv));
end
Note that MATLAB ignores any lines that start with a % - this is to allow you to type comments
into your programs that will help you, or users of your programs, to understand them.
Save the file (accept the default file name, which is magnitude.m)
4. Type the following into the command window
>>x = [1,2,3];
>> magnitude(x)

w

Note the syntax for defining a function — it must always have the form
function solution_variable = function_name(input_variables...)

...script that computes the function, ending with the command:

solution_variable = ....
end

You can visualize the way a function works ¥
using the picture. Think of the ‘input e 2
variables’ as grass (the stuff cows eat, that is, s Computations
not the other kind of grass); the body of the  Solution |gireide functio
script as the cow’s many stomachs, and the variable(s)
solution variable as what comes out of the

other end of the cow.




A cow can eat many different vegetables, and you can put what comes out of the cow in many different
containers. A function is the same: you can pass different variables or numbers into a function, and you
can assign the output to any variable you like — try >> resultl = magnitude([3,4]) or >> result2 =
magnitude([2,4,6,8]) for example.

If you are writing functions for other people to use, it is a good idea to provide some help for the function,
and some error checking to stop users doing stupid things. MATLAB treats the comment lines that
appear just under the function name in a function as help, so if you type

>> help magnitude
into the command window, MATLAB will tell you what “magnitude’ does. You could also edit the
program a bit to make sure that v is a vector, as follows

function y = magnhitude(v)
% Function to compute the magnitude of a vector

% Check that v is a vector
[m,n] = size(v); % [m,n] are the number of rows and columns of v
% The next line checks i1f both m and n are >1, In which case v 1is
% a matrix, or if both m=1 and n=1, 1in which case v scalar; if either,
% an error is returned
iT(C(m>D&M>1) )] (m=1&n-=1))
error("Input must be a vector®)
end

y = sqgrt(dot(v,Vv));
end

This program shows another important programming concept. The “if...... end” set of commands is
called a “conditional” statement. You use it like this:
if (atest)
calculation to do if the test is true
end
In this case the calculation is only done if test is true — otherwise the calculation is skipped altogether.
You can also do
if (atest)
calculation to do if the test is true
else if (asecond test)
calculation to do if the first test is false and the second test is true
else
calculation to do if both tests are false
end
In the example (m > 1) & (n > 1) means “m>1and n>1" while ] (m == 1 & n == 1) means
“or m=1 and n=1". The symbols & and | are shorthand for "and’ and ‘or’.

Functions can accept or return data as numbers, arrays, strings, or even more abstract data types. For
example, the program below is used by many engineers as a substitute for social skills

function s = pickup(person)

% function to say hello to someone cute

s = ["Hello " person " you are cute"]

beep;
end



(If you try to cut and paste this function into MATLAB the quotation marks will probably come out
wrong in the Matlab file and the function won’t work. The quotes are all ‘close single quote’ on your
keyboard — you will need to correct them by hand.)

You can try this out with

>> pickup(‘Janet”)
(Janet happens to be my wife’s name. If you are also called Janet please don’t attach any significance to
this example)

You can also pass functions into other functions. For example, create an M-file with this program
function plotit(func_to_plot,xmin,xmax,npoints)
% plot a graph of a function of a single variable f(x)
% from xmin to xmax, with npoints data points
for n=1:npoints
x(n) = xmin + (xmax-xmin)*(n-1)/(npoints-1);
v(n) = func_to_plot(x(n));
end
figure;
plot(x,v);
end
Then save the M-file, and try plotting a cosine, by using
>> plotit(@cos,0,4*pi,100)

Several new concepts have been introduced here — firstly, notice that variables (like func_to_plot in this
example) don’t necessarily have to contain numbers, or even strings. They can be more complicated
things called “objects.” We won’t discuss objects and object oriented programming here, but the example
shows that a variable can contain a function. To see this, try the following

>> v = @exp

>>v(1)
This assigns the exponential function to a variable called v — which then behaves just like the exponential
function. The ‘@’ before the exp is called a ‘function handle’ — it tells MATLAB that the function
exp(x), should be assigned to v, instead of just a variable called exp.

The ‘@’ in front of cos “plotit(@cos,0,4*pi,100)” assigns the cosine function to the variable called
func_to_plot inside the function.

Although MATLAB is not really intended to be a programming language, you can use it to write some
quite complicated code, and it is widely used by engineers for this purpose. CS4 will give you a good
introduction to MATLAB programming. But if you want to write a real program you should use a
genuine programming language, like C, C++, Java, lisp, etc.

IMPORTANT: You may have got used to writing scripts in EN30 without defining them as functions.
For the calculations you will be doing in EN40, it will be essential to make all your scripts define a
function. This means you must start the script with “function name of function’ and terminate it with an
‘end’ statement. An example is shown below.

function My Design Project

%UNTITLED3 Summary of this function goes here
% Detailed explanation goes here

end



If you like, you can automatically create a new function by using the New>Function menu, (For your
EN4 assignments, you will usually delete the input and output arguments for the function).

12. Organizing complicated calculations as functions in an M file

It can be very helpful to divide a long and complicated calculation into a sequence of smaller ones, which
are done by separate functions in an M file. As a very simple example, the M file shown below creates
plots a pseudo-random function of time, then computes the root-mean-square of the signal. Copy and
paste the example into a new MATLAB M-file, and press the green arrow to see what it does.

function randomsignal
% Function to plot a random signal and compute its RMS.

close all % This closes any open figure windows

npoints = 100; % No. points in the plot
dtime = 0.01; % Time interval between points

% Compute vectors of time and the value of the function.

% This example shows how a function can calculate several

% things at the same time.

[time,function_value] = create_random_function(npoints,dtime);

% Compute the rms value of the function
rms = compute_rms(time,function_value);

% Plot the function
plot(time, function_value);
% Write the rms value as a label on the plot
label = strcat("rms signal = " ,num2str(rms));
annotation( " textbox","String”,{label}, "FontSize",16, ...
"BackgroundColor®,[1 1 1],...
"Position”,[0.3499 0.6924 0.3944 0.1]);

end
%
function [t,y] = create_random_function(npoints,time_interval)
% Create a vector of equally spaced times t(i), and
% a vector y(i), of random values with i=1..npoints
for 1 = l:npoints
t(i) = time_interval*(i-1);
% The rand function computes a random number between 0 and 1
y(i) = rand-0.5;
end

end



function r = compute_rms(t,y)
% Function to compute the rms value of a function y of time t.
% t and y must both be vectors of the same length.
for 1 = 1:length(y) %You could avoid this loop with . notation
ysquared(i) = y(i)*y(i);
end
% The trapz function uses a trapezoidal integration
% method to compute the integral of a function.
integral = trapz(t,ysquared);

r = sqrt(integral/t(length(t))); % This iIs the rms.
end

Some remarks on this example:
1. Note that the m-file is organized as

main function — this does the whole calculation
result 1 = functionl(data)
result2 = function2(data)

end of main function

Definition of function 1

Definition of function2

When you press the green arrow to execute the M file, MATLAB will execute all the statements
that appear in the main function. The statements in functionl and function2 will only be
executed if the function is used inside the main function; otherwise they just sit there waiting
to be asked to do something. A bit like an engineer at a party...

2. When functions follow each other in sequence, as shown in this example, then variables defined
in one function are invisible to all the other functions. For example, the variable ‘integral’ only
has a value inside the function compute_rms. It does not have a wvalue in
create_random_function.



13. Solving differential equations with MATLAB

The main application of MATLAB in EN40 is to analyze motion of an engineering system. To do this,
you always need to solve a differential equation. MATLAB has powerful numerical methods to solve
differential equations. They are best illustrated by means of examples.

Before you work through this section it is very important that you are comfortable with the way a
MATLAB function works. Remember, a MATLAB function takes some input variables, uses them to
do some calculations, and then returns some output variables.

13.1 What is a differential equation?

Differential equations are mathematical models used by engineers, physicists, mathematical biologists,
and even economists. For example, crude economic models say that the rate of growth of the GDP g of a
country is proportional to its GDP, giving the differential equation

dg

ot kg (t)
This is an equation for the unknown function g(t). Basically, it says that if g is small, it increases slowly;
if g is large, it increases quickly. If you know the value of g at time t=0 (eg g(0) = gg), the equation can

be solved to see that g(t)=ggexp(kt) (you should know how to do this — separate variables and
integrate).

Thus
o A differential equation is an algebraic equation for an unknown function of a single variable (e.g.
g(t). The equation involves derivatives of the function with respect to its argument.
e To solve a differential equation, you need to know initial conditions or boundary conditions that
specify the value of the function (and/or its time derivatives) at some known instant.

There are many different kinds of differential equation — your math courses will discuss them in more
detail. In this course, we will usually want to solve differential equations that describe the motion of some
mechanical system. We will often need to solve for more than one variable at the same time. For
example, the x,y,z coordinates of a satellite orbiting a planet satisfy the equations

d2x_ kx d2y_ ky dzz_ kz

2 3/2 2 3/2 2 3/2
dt (Xz N yz +22) dt (Xz n yz +22) dt (Xz N yz +22)
where k is a constant. We will see many other examples. All the differential equations we solve will
come from Newtons law F=ma (or rotational equations for rigid bodies), and so are generally second
order differential equations (they contain the second derivative of position with respect to time).

13.2 Solving a basic differential equation using the command window.

Suppose we want to solve the following equation for the unknown function y(t) (where t is time)
dy .
— =-10y +sin(t
pm y +sin(t)



with initial conditions y=0 at time t=0. We are interested in calculating y as a function of time — say

from time t=0 to t=20. We won’t actually compute a formula for y — instead, we calculate the value of y
at a series of different times in this interval, and then plot the result.

We would do this as follows

N . dy . .
1. Create a function (in an m-file) that calculates d—i/ given values of y and t. Create an m-file as

follows, and save it in a file called ‘simple_ode.m’
function dydt = simple_ode(t,y)
% Example of a MATLAB differential equation function

dydt = -10*y + sin(t);
end

It’s important to understand what this function is doing.  Remember, (t,y) are the ‘input
variables’ to the function.  ‘dydt’ is the ‘output variable’. So, if you type value =
simple_ode(some value of t, some value of y ) the function will compute the value of dydt for the
corresponding (t,y), and put the answer in a variable called ‘value’. To explore what the function
does, try typing the following into the MATLAB command window.

>> simple_ode(0,0)

>> simple_ode(0,1)

>> simple_ode(pi/2,0)
For these three examples, the function returns the value of dy/dt for (t=0,y=0); (t=0,y=1) and
(t=pi,y=0), respectively. Do the calculation in your head to check that the function is working.

2. Now, you can tell MATLAB to solve the differential equation for y and plot the solution. To do
this, type the following commands into the MATLAB command window.

>> [t_values,y_values] = ode45(@(t,y) simple_ode(t,y) ,[0,20],0);
>> plot(t_values,y_values)

Here,

oded5(@(variables) function_name(variables),[start time, end time], initial value of variable y)

is a special MATLAB function that will integrate the differential

File Edit Yiew [msent Took Desktep Window Help

equation (numerically). Note that a “function handle’ (the @) has |2@ds & “~ 99w 8 08 a5
to be used to tell MATLAB the name of the function to be
integrated. i ‘

Your graph should look like the plot shown on the right.

Easy? Absolutely! But there is a great deal of sophisticated
math and programming hidden in the built-in numerical
functions of MATLAB. e




Let’s look a bit more carefully at how the ODE solver works. Think about the command
>> [t _values,y_values] = oded5(@(t,y) simple_ode(t,y) ,[0,20],0);

This is calling an internal MATLAB function called ‘ode45’. Like all functions, ode45 takes some input
variables, digests them, and produces some output variables. Here, the input variables are
1. @(ty) simple_ode(t,y) specifies the name of the function that computes the time derivative
(simple_ode). It must be preceded by an @ to tell MATLAB that this variable is a function.
You must always write this function yourself, and it must always have the form
function dydt = name_of function(t,y)
% MATLAB differential equation function
% Do some calculations here to compute the value of dydt
dydt = ..
end
2. The time interval for which you would like to calculate y, specified as [start time, end time].
3. The value of y at start time.

Now let’s look at the ‘output variables’ from ode45. The output variables are two vectors called
t values, y_values. (Of course you can give these different names if you like). To see what’s in the
vectors, type

>>1t values

>>y values
The vector ‘t_values’ contains a set of time values. The vector ‘y_values’ contains the value of ‘y” at
each of these times.

Yy [y(t) |

t y(t2)
t_values=| t3 y_values =| y(t3)

ty y(ts)

So when we typed plot(t_values,y_values) _We_ got a graph of y_ as a_function of t (look back at how
MATLAB plots work — Section 9 - if you need to).

It’s important to understand that MATLAB has not given you a formula for y as a function of time.
Instead, it has given you numbers for the value of the solution y at a set of different times.

HEALTH WARNING: It is not easy to understand how MATLAB is using the ‘simple_ode’ function.
This is discussed in a bit more detail in Section 13.9 — for now the important thing is to work out how to
use the function, but you could glance through 13.9 and see if it makes any sense to you — if it does, it
might be clearer how ode45 works.



13.3 Solving a basic differential equation in an M-file This is an important section of this tutorial

Let’s work through a second example, but this time write a MATLAB ‘m’ file to plot the solution to a
differential equation. This is the way we normally use MATLAB - you can solve most problems by just
modifying the code below. As an example, let’s solve the Bernoulli differential equation

dy 1
E_6(ty4+2y)

with initial condition y =—2 at time t=0. Here’s an ‘m’ file to do this

function solve_bernoulli
% Function to solve dy/dt = (t*y™4+2y)/6
% from time t=0 to t=20, with y(0) = -2
initial_y = -2;
time_range = [0,20];

[t values,sol values] = ode45(@(t,y) diff_eq(t,y),time_range,initial_y);
plot(t_values,sol_values); % Plot the solution
end % end statement terminating the solve bernoulli function

function dydt = diff_eq(t,y) % Function defining the ODE
dydt = (t*y™4+2*y)/6;
end % end statement terminating the diff_eq function

Notice how the code’s been written. We created a function to compute the value of dy/dt given a value
fortandy. This is the function called ‘diff_eq’.

Notice that the “diff_eq’ function comes after the line that computes the solution to the ODE (the line
with ‘ode45’ in it), but that doesn’t matter. When MATLAB executes your ‘m’ file, it first scans through
the file and looks for all the functions — these are then stored internally and can be evaluated at any time
in the code. It is common to put the functions near the end of the file so they can easily be found. In fact
the diff_eq function could even be stored in a different file.

The solution to the ODE is computed on the line
[t values,sol values] = ode45(@(t,y) diff_eq(t,y),time_range,initial_y);
The function handle @(t,y) diff_eq(t,y) isused to tell MATLAB two things:

1. Which function to use to compute the value of dy/dt. MATLAB will be repeatedly using your
function internally to compute dy/dt at many different times between t=0 and t=20, but you don’t
see this happening.

2. The @(t,y) tells matlab that the variable y is differentiated with respect to t in the equation.

These are dummy variables, so, for example this would work just as well:
[t values,sol values] = ode45(@(x,z) diff _eq(x,z),time_range,initial_y);

The main reason that this procedure hard to follow is that it’s difficult to see how MATLAB is using your
differential equation function — this is buried inside MATLAB code that you can’t see. We will discuss
this in class, but if you can’t wait to find out, you can read section 13.9 and see if you can work out
what’s going on by yourself.



13.4 Solving a differential equation with adjustable parameters.

For design purposes, we often want to solve equations which include design parameters. For example, we
might want to solve

% =—ky + F sin(at)
with different values of k, F and @, so we can explore how the system behaves. We can do this using the

script shown below

function ode_to_a nightingale
% Function to solve dy/dt = -k*y + F*sin(omega*t)
% from t=tstart to t=tstop, with y(0) = initial_y

close all % Closes any open plot windows.

% Define parameter values below.
k = 10;
F=1;
omega = 1;
time_range = [0,20];
y0 = 0;

[t _values,sol _values] = ode4d5(@(t,y) diff_eq(t,y,k,F,omega), - -.
time_range,y0);

plot(t_values,sol_values);
end % Here is the end of the “solve my ode” function

function dydt = diff_eq(t,y, k, F, omega) % Function defining the ODE
dydt = -k*y + F*sin(omega*t);
end

Notice that:
1. We can add additional variables to our differential equation function
function dydt = diff_eq(t,y, k, F, omega)

The variables can appear in any order you like.

2. You have to specify that y is differentiated with respect to t with @(t,y)

3. You have to list all the variables in the function in the ode45 line:
e(t,y) diff_eq(t,y.k,F,omega), ...
The order has to be consistent

Now you can solve the ODE by executing the M-file. You can get solutions with different parameter
values quickly by editing the M-file.



13.5 Common errors

The examples below show the errors you get if you get functions in the wrong order when you solve a
differential equation. Start with a code that works:

function ode_to_a nightingale

% Function to solve dy/dt = -k*y + F*sin(omega*t)

% from t=tstart to t=tstop, with y(0) = initial_y

close all % Closes any open plot windows.

% Define parameter values below.
k = 10;
F=1;
omega = 1;
time_range = [0,20];
y0 = 0;

[t values,sol values] = ode45(@(t,y) diff _eq(t,y,k,F,omega), ...
time_range,y0);
plot(t values,sol values);

end

function dydt = diff_eq(t,y, k, F, omega) % Function defining the ODE
dydt = -k*y + F*sin(omega*t);

end

Example 1 Now try moving the line that solves the ODE to the top of the script:

function ode_to_a nightingale
% Function to solve dy/dt = -k*y + F*sin(omega*t)
% from t=tstart to t=tstop, with y(0) = initial_y

close all % Closes any open plot windows.

[t values,sol values] = ode45(@(t,y) diff _eq(t,y,k,F,omega), ...
time_range,y0);

% Define parameter values below.
k = 10;
F=1;
omega = 1;
time_range = [0,20];
y0 = 0;

plot(t _values,sol values);

end

function dydt = diff_eq(t,y, k, F, omega) % Function defining the ODE
dydt = -k*y + F*sin(omega*t);

end



This bombs (check the command window to see the error). The reason is that MATLAB executes
statements in the following order (i) It scans your file for functions, and stores them in memory so they
are ready to be used; (ii) it executes the statement in the main function from the top down. So, in this
example, MATLAB (i) stores the diff_eq function in memory; (ii) closes figure windows; (iii) attempts to
solve the differential equation. But it can’t do this because the variables tstart, tstop, and initial_y have
not been given values.

Example 2: Try fixing the problem by defining tstart, tstop, and initial_y properly, but leave the
definition of k,F and omega where they are

function ode_to_a nightingale
% Function to solve dy/dt = -k*y + F*sin(omega*t)
% from t=tstart to t=tstop, with y(0) = initial_ y

close all % Closes any open plot windows.

tstart = 0;
time_range = [0,20];
y0 = 0;

[t values,sol values] = ode45(@(t,y) diff _eq(t,y,k,F,omega), ...
time_range,y0);

% Define parameter values below.
k = 10;
F=1;
omega = 1;

plot(t _values,sol values);

end

function dydt = diff _eq(t,y, k, F, omega) % Function defining the ODE
dydt = -k*y + F*sin(omega*t);

end

Again, this bombs with a whole string of errors. The reason is a bit more difficult to understand. This
time, Matlab (i) stores the diff_eq function in memory; (ii) closes figure windows; (iii) assigns values to
tstart, tstop and initial_y; (iii) attempts to solve the differential equation. When it solves the differential
equation, MATLAB needs to use your diff_eq function, which has to compute a numerical value for dydt
given values for t,y,k,and F. But the values of k,F and omega have not yet been specified, which causes
MATLAB to crash.

Example 3: Try forgetting one of the k,F and omega variables

function ode_to_a nightingale
% Function to solve dy/dt = -k*y + F*sin(omega*t)
% from t=tstart to t=tstop, with y(0) = initial_y

close all % Closes any open plot windows.
% Define parameter values below.

k 10;
F 1;



omega = 1;
time_range = [0,20];
y0 = 0O;

[t values,sol values] = ode45(@(t,y) diff _eq(t,y,.k,omega),...
time_range,y0);
plot(t_values,sol_values);

end

function dydt = diff_eq(t,y, k, omega) % Function defining the ODE
dydt = -k*y + F*sin(omega*t);

end

This produces Undefined function or variable 'F'.

Example 4: Try forgetting one of the k,F and omega in the ode45 line

function ode_to_a nightingale
% Function to solve dy/dt = -k*y + F*sin(omega*t)
% from t=tstart to t=tstop, with y(0) = initial_ y

close all % Closes any open plot windows.

% Define parameter values below.
k = 10;
F=1;
omega = 1;
time_range = [0,20];
y0 = 0;

[t values,sol values] = ode45(@(t,y) diff _eq(t,y,.k,omega),...
time_range,y0);
plot(t_values,sol_values);

end

function dydt = diff_eq(t,y, k, F omega) % Function defining the ODE
dydt = -k*y + F*sin(omega*t);

end

This produces Not enough input arguments.

13.6 Solving simultaneous differential equations This is an important section of this tutorial

Most problems in engineering involve more complicated differential equations than those described in the
preceding section. Usually, we need to solve several differential equations at once. As an example, we
will solve a homework problem from 2012. The famous ‘Belousov-Zhabotinskii reaction is an example of
a chemical reaction that results in cyclic variations in concentration of the reagents (you can find movies
showing the reaction). Reactions of this type are of interest in biology, and a number of theoretical
models have been developed to describe them. One example is the ‘cubic autocatalator’ reaction, which
is described by differential equations



http://books.google.com/books?id=2d-RLuD_MX8C&pg=PA54&lpg=PA54&dq=belousov+zhabotinskii&source=bl&ots=SuF3vF53O7&sig=d5yCNMN96QvxYS4njs673pB3Vgo&hl=en&ei=0-NDTqOBBoTk0QG08ZWrCQ&sa=X&oi=book_result&ct=result&resnum=10&ved=0CFwQ6AEwCTgo#v=onepage&q=belousov%25
http://www.youtube.com/watch?v=IBa4kgXI4Cg

dx 2 dy 2

—=0.6-xy“ —0.1x —=xy° —-y+0.1x

dt d a7

Here, x(t) and y(t) represent the concentrations of two reacting chemicals. The point of the equations is to
predict how the concentrations fluctuate with time. The two equations specify how quickly each

concentration varies, given the concentration values.
Our mission is to calculate and plot the time variation of x and y, given that at time t=0 x=y=1.

To do this, we must first define a function that will calculate values for both dx/dt and dy/dt given values
of x,y and time. MATLAB can do this if we re-write the equations we are trying to solve as a vector,

which looks like this
d {x} ~ 0.6—xy2 —0.1x
dt|y xy? — y +0.1x

This is an equation that has the general form
dw
—=f(t,w
m (t,w)

)

If we write a MATLAB function to compute dw/dt given w, then MATLAB will be able to solve the
differential equation. Here’s a script that does this.

function 1_love_chemical_engineering

% Function to solve the cubic autocatalator equations

where w is a column vector

close all % Closes any open plot windows.
time_range = [0,100];

x0 = 1; % Initial value of x
y0 = 1; % Initial value of y
initial_w = [x0;y0]; % Initial value of the vector w

[t values,sol values] = ode45(@(t,w) diff _eq(t,w),time_range,initial_w);
plot(t_values,sol_values);

end
function dw_vectordt = diff_eq(t,w_vector) % Function defining the ODE
X = w_vector(l); % x is stored as the first element in w_vector
y = w_vector(2); % y is stored as the second element in w_vector
dxdt = 0.6-x*y"2-0.1*X;
dydt = x*y"2-y+0.1*X;
dw_vectordt = [dxdt; dydt]; % The time derivative of w_vector
end

You should see a plot that looks like the figure. The graph
shows the variation of x (blue line) and y (red line) with time. L]
The concentrations fluctuate about once every 10 seconds or wll
so (this was the point of the calculation!) “‘

Some notes on this example:




e The general procedure is exactly the same as for solving a single differential equation. The only
change is that now the unknown variable is a vector, the initial value of the variable is a vector,
and the solution contains values for both x and .

e A common error when solving vector valued differential equations is to forget to make the

dw_vectordt column vector. Try this by editing your code to
dw_vectordt = [dxdt, dydt];

This produces the error
Error using odearguments (line 93)
@(T,W)DIFF_EQ(T,W) must return a column vector.

Again, this is in classical geek and incomprehensible to most of us — just remember that if you get an
error that has something to do with column vectors it is usually a problem in your differential equation
function.

We also need to take a closer look at the way MATLAB gives you the solution. When we solved a scalar
equation, the solution was a vector of time values, together with a vector of solution values. In this
calculation, the variable ‘t_values’ still stores a bunch of time values where the solution has been
computed. But now MATLAB has computed a bunch of vectors at every time. How is the result
stored?

The answer is that the variable ‘sol_values’ is a matrix. To see what’s in the matrix, suppose that
solution values x,y were computed at a bunch of different times t;,t,,t3.... The variables ‘time_values’

and ‘sol_values’ then contain a vector and a matrix that look like this

4 x(t)  y(t) ]

t, x(tz) y(t2)
t_values=|t3 sol _values =| x(t3) y(t3)

ty X(tg) y(tsg)

Each row in the matrix ‘sol’ corresponds to the solution at a particular time; each column in the matrix
corresponds to a different component for the vector valued solution. For example, the solution for x at
time times(i) can be extracted as sols(i,1), while the solution for v, is sols(i,2).

Understanding this lets us plot the solution in many different ways (try them by editing your script):
e Toplotonly x asa function of time use plot(t_values,sol_ sol_values(:,1))
e Toplotonly y asa function of time use plot(t_values,sol_ sol_values(:,2))
e Toplot x onthe x axis—v- y on the y axis use
plot(sol _values(:,1),sol _values(:,2))
In each case, the “:” tells MATLAB to use all the rows in the matrix for the plot.



13.7 Controlling the accuracy of solutions to differential equations.

It is important to remember that MATLAB is not calculating the exact solution to your differential
equation — it is giving you an approximate solution, which has been obtained using some sophisticated
(and buried) computational machinery. MATLAB allows you to control the accuracy of the solution
using three parameters, defined as follows. Suppose that y =[y;,y,...y,] is the solution to your ODE.

MATLAB computes the relative error for each variable, defined as:

g = (yiMatIab _ yicorrect)/ yi(:orrect
(“How does MATLAB know the correct solution? And if it knows, why doesn’t it just give the correct
solution?” I hear you cry... Good questions. You can pay some more tuition and sign up for a numerical
methods course in a future semester to find out...). You can control the accuracy of the solution by
telling MATLAB what relative tolerance you would like, as shown in the code sample below

function 1_love_chemical_engineering
% Function to solve the cubic autocatalator equations

close all % Closes any open plot windows.

time_range = [0,100];

x0 = 1; % Initial value of x

y0 = 1; % Initial value of y

initial_w [x0;y0]; % Initial value of the vector w

options = odeset("RelTol",0.00001);

[t _values,sol_values] = ode45(@(t,w) diff_eq(t,w),...
time_range, initial_w,options);

plot(t_values,sol_values);

end
function dw_vectordt = diff_eq(t,w_vector) % Function defining the ODE
X = w_vector(l); % x is stored as the first element in w
y = w_vector(2); % y = stored as the second element in w
dxdt = 0.6-x*y"2-0.1*x;
dydt = x*y"2-y+0.1*X;
dw_vectordt = [dxdt; dydt]; % The time derivative of w
end

Here, the ‘odeset(‘variable name’,value,...) function is used to set values for special control variables in
the MATLAB differential equation solver. This example sets the relative tolerance to 107°.



13.8 Looking for special events in a solution

In many calculations, you aren’t really interested in the time-history of the solution — instead, you are
interested in learning about something special that happens to the system. For example, in the chemistry
example you might be interested in finding the time when the two concentrations x, y first have equal
values. The script below shows how to do this.

function 1_love_chemical_engineering
% Function to solve the cubic autocatalator equation

close all % Closes any open plot windows.

time_range = [0,100];

x0 = 1; % Initial value of Xx

y0 = 1; % Initial value of y

initial_w = [x0;y0]; % Initial value of the vector w

options = odeset("RelTol",0.00001,...
"Events®,@(t,w) event_function(t,w));

[t values,sol values] = ode45(@(t,w) diff _eq(t,w), ...
time_range, initial_w,options);
plot(t values,sol values);

figure
yminusx = sol_values(:,2)-sol _values(:,1);
plot(t_values,yminusx);

function dw_vectordt = diff_eq(t,w_vector) % Function defining the ODE
X = w_vector(1l); % x is stored as the first element In w
y = w_vector(2); % y = stored as the second element in w
dxdt = 0.6-x*y"2-0.1*X;
dydt = x*y"2-y+0.1%*x;
dw_vectordt = [dxdt; dydt]; % The time derivative of w
end

function [ev,stop,dir] = event_function(t,w_vector)
X = w_vector(1l); % x is stored as the Tirst element in w
y = w_vector(2); % y = stored as the second element in w
ev = y-X; % “Events’ are detected when eventvalue=0
stop = 1; % stop if event occurs
dir = -1; % Detect only events with devdt<O

end

Notice that the code now produces two figures — the first figure shows x and y as a function of time, as
before (notice that the code stops when x=y, as required).

The second plot shows the value of y-x. Notice that y-x goes to zero, again, as expected.

Here is an explanation of what’s happening in this example. First, notice the new line
options = odeset("RelTol",0.00001, ...
"Events”,@(t,w) event_ function(t,w));



The second line tells MATLAB that you want to look for a special event, and that a function called
‘event_function” will be used to specify what you are interested in. The ‘options’ variable in the call to
ode45 passes this information to the ODE solver, so MATLAB knows where to look for your function.

It is important to understand how MATLAB will use the function called ‘events.” There is a line inside
the ode45 function in MATLAB that repeatedly calls your function with different values of time t and the
solution vector w. For each value of t and w, your function computes values for the three variables [ev,
stop,dir]. You must write the function so that the value of the ‘eventvalue’ goes to zero whenever the
values of t and w reach values you are interested in.

The MATLAB ODE solver then uses your function as though it were playing the ‘hot and cold’ game
with you. MATLARB tries lots of different values of the solution (t,w) (you never see this happening —
the ‘event’ function is called internally from the ODE solver function). Your function must then tell
MATLAB whether the values of (t,w) are getting close to the ‘event’ you are interested in. It does this by
computing values for [ev, stop,dir]. Here’s what the variables do:

1. The value of ‘ev’ tells MATLAB when the event occurs. You should write your function so that
‘eventvalue’ goes smoothly to zero as the event you wish to detect is approached. ‘ev’ will
always be some function of time t and the variables stored in the vector w. Here, we are simply
interested in finding when y=x, so we set ‘eventvalue=y-x’.

2. ‘stop’ tells MATLAB whether or not to continue the calculation if it detects the event. If you set
‘stop=1" it will stop; otherwise if you set ‘stop=0’ it will continue.

3. “dir’ gives you some additional control over event. In general, the variable ‘ev’ could start
positive, and then decrease until it reaches zero, or could start negative, and then increase until it
reaches zero. Sometimes you may only be interested in one of these two cases. You can tell
MATLAB this by assigning the correct value to the variable “dir’ as follows
e If "dir=0" MATLAB will detect an event each time “eventvalue=0’

o If ‘dir=1" MATLAB will respond only when eventvalue=0 and is increasing

o If ‘dir=-1" MATLAB will respond only when eventvalue=0 and is decreasing.
Try changing the code to dir = +1; and see what happens. Notice that the calculation still stops when
y=x, but now y-x is increasing when the calculation terminates.

13.9 How the ODE solver works

It is helpful to have a rough idea of how MATLAB solves a differential equation. To do this, we’ll first
come up with a simple (but not very good) way to integrate an arbitrary differential equation. Then we’ll
code our own version of MATLAB’s ode45() function.

Let’s take another look at the first differential equation discussed in section 13.2. We would like to find a
function y(t) that satisfies

dy .
—=-10y +sin(t
pm y +sin(t)

with y=0 at time t=0. We won’t attempt to find an algebraic formula for y — instead, we will just
compute the value of y at a series of different times between t=0 and t=20 -say t=0,t =0.1,t =0.2...
To see how to do this, remember the definition of a derivative

dy i YEAD -y (D)

dt  At—0 At
So if we know the values of y and dy / dt at some time t, we can use this formula backwards to calculate
the value of y at a slightly later time t + At


http://www.boyscouttrail.com/content/game/game-417.asp

dy

dt

This procedure can be repeated to find all the values of y we need. We can do the calculation in a small
loop. Try copying the function below in a new M-file, and run it to see what it does.

y(t+At) = y(t) + At

function simple_ode_solution
% The initial values of y and t

y(1) = 0;

t(1) = 0;

delta_ t = 0.1;
n_steps = 20/delta_t;

for 1 = 1l:n_steps
dydt = -10*y(i) + sin(t(i)); % Compute the derivative
y(i+l) = y(i1) + delta t*dydt; % Find y at time t+delta_ t
t(i+l) = t(i) + delta_t; % Store the time

end

plot(t,y);
end

This function is quite complicated, so let’s look at how it works. Start by noticing that t and y are two
vectors, which contain values of time t and the corresponding value of y at each time. The function just
computes and plots these vectors — it accomplishes the same task as ode45.

Now let’s take a look at how the vectors are calculated. We know that at time t=0, y is zero. So we put
these in the first entry in the vector: y(1) = 0; t(1) = 0.  Next, we want to fill in the rest of the vector.
We first need to calculate how long the vector will be: the line delta_t = 0.1 chooses the time
interval At, and then n_steps = 20/delta_t calculates how many time intervals are required to
reach t=20sec. Finally, look at the ‘for i=1:nsteps ... end’ loop. The calculation starts with i=1. For
this value of i, the program first calculates the value of dydt, using the values of y(1) and t(1). Then it
uses dydt to calculate the value of y(2), and calculates the corresponding value of t(2). The calculation is
repeated with i=2 — this defines the value of y(3) and t(3). This procedure is repeated until all the values
in the vectors t and y have been assembled.

Now, we can use this idea to write a more general function that behaves like the MATLAB ode45()
function for solving an arbitrary differential equation. Cut and paste the code below into a new M-file,
and then save it in a file called my_ode45.

function [t,y] = my_oded45(ode_function,time_int,initial_y)

y(1) = initial_y;

t(1) = time_int(1l);

n_steps = 200;

delta_t = (time_int(2)-time_int(1))/n_steps;

for 1 = 1:n_steps
dydt = ode_function(t(i),y(1));% Compute the derivative
y(i+l) = y(i) + delta _t*dydt;% Find y at time t+delta t
t(i+l) = t(i) + delta _t;% Store the time

end

end



You can now use this function just like the built-in MATLAB ODE solver. Try it by typing

>> [t _values,y_values] = my_ode45(@(t,y) simple_ode(t,y),[0,20],0);

>> plot(t_values,y_values)
into the MATLAB command window (if you get an error, make sure your simple_ode function defined in
Section 13.2 is stored in the same directory as the function my_ode45).

Of course, the MATLAB equation solver is actually much more sophisticated than this simple code, but it
is based on the same idea.

13.10 Other MATLAB ODE solvers

The solver called ‘ode45’ is the basic MATLAB work-horse for solving differential equations. It works
for most ODEs, but not all. MATLAB has many other choices if ‘ode45’ doesn’t work. Using them is
very similar to using ‘ode45’ but they use different numerical algorithms to solve the equations. You can
learn a lot more about MATLAB ODE solvers in the section of the manual shown below
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14. Using MATLAB optimizers and solvers to make design decisions

In engineering, the reason we solve equations of motion is usually so that we can select design parameters
to make a system behave in a particular way. MATLAB has powerful equation solvers and optimizers
that can be helpful to do this kind of calculation.

14.1 Using fzero to solve equations
The simplest design decisions involve selecting a single design parameter to accomplish some objective.

If this is the case, you can always express your design problem in the form of a nonlinear equation, which
looks something like



f(x)=0
where f is some very complicated function — perhaps involving the solution to an equation of motion.
MATLAB can solve this kind of equation using the “fzero’ function.

As a very simple example, here’s an ‘m’ file that will solve the equation x+sin(x) =0,

function solveequation
% Simple example using fsolve to solve x + sin(x)=0

sol_for_x = fzero(@(x) fofx(x),[-100,100])

end

function f = fofx(x)

% Function to calculate f(X) = x + sin(X)
f = x+sin(X);

end

Notice that ‘fsolve’ works much like the ODE solver - The function ‘fzero(@(variable)
function(variable),[initial guess 1,initial guess 2])’. The two initial guesses should bracket the solution —
in other words, f(x) should change sign somewhere between x=initial guessl and x=initial guess2. The
solution to the equation is printed to the main MATLAB window.

14.2 Simple unconstrained optimization example

MATLAB has a very powerful suite of algorithms for numerical optimization. The simplest optimizer is
a function called ‘fminsearch,” which will look for the minimum of a function of several (unconstrained)
variables.

As a very simple example, let’s try to find the value of x that minimizes the function
2
f(x)=(x-5) +4

function minimizef
% Function to compute projectile velocity required to hit a target
% target_position is the distance from the launch point to the target

optimal_x = fminsearch(@(x) fofx(x),[3])

end

function f = fofx(x)

% Function to calculate F(xX)=(x-5)"2+4
T = (x-5)"2+4;

end

The script should be fairly self-explanatory. The function fminsearch(@function,guess) tries to
minimize ‘function’ starting with an initial guess ‘guess’ for the solution. If the function has many
minima, it will always return the first solution that it finds, by marching downhill from the *guess.’



For example, modify your script to minimize f(Xx)=sin(x)+X. Try to find three or four minima by
starting with different initial guesses.

Note that MATLAB has no explicit function to maximize anything. That’s because there’s no need for
one. You can always turn the problem: ‘maximize f(x) into ‘minimize —f(x)’.

MATLAB can also optimize a function of many variables. For example, suppose we want to find values
of x,y that minimize

z(x, y) =sin(x) cos(y)
We can do this as follows

function minimizez
% Function to find values of x and y that minimize sin(x)*cos(y)

optimal_xy = fminsearch(@(w) zofw(w),[1,2])

end

function z = zofw(w)
% w Is now a vector. We choose to make w(1)=x, w(2)=y

x = w(1); y=w(2);
z = sin(x)*cos(y);
end

The only thing that has changed here is that our function zofw is now a function of a vector w=[x,y] that
contains values of both x and y.  We also need to give MATLAB a vector valued initial guess for the
optimal point (we used x=1,y=2).

You can include as many variables as you like in the vector w.

14.3 Optimizing with constraints

You are probably aware by now that most engineering optimization problems involve many constraints —
i.e. limits on the admissible values of design parameters. MATLAB can handle many different kinds of
constraint.

We’ll start by summarizing all the different sorts of constraints that MATLAB can handle. As a specific
example, let’s suppose that we want to minimize
z(x, y) =sin(x) cos(y)
We could:
1. Find a solution that lies in a particular range of x and y. This could be a square region
Xmin SX< Xmax ymin < y = ymax
or, for something a bit more complicated, we might want to search over a triangular region
0< X< X X+2y<4
2. Search along a straight line in x,y space — for example, find the values of x and y that minimize
the function, subject to
3x-10y =14
3. Search in some funny region of space — maybe in a circular region



(x—3)*+(y-8)°<10
4. Search along a curve in X,y space — e.g. find the values of x and y that minimize the function, with
x and y on a circle with radius \/§
x> +y*=3
In really complicated problems, you could combine all four types of constraint. MATLAB can handle all

of these. Here, we’ll just illustrate cases 1 and 2 (this is all you need if you want to use the optimizer in
your design projects).

As a specific example, let’s suppose we want to minimize
z(x,y) =sin(x)cos(y)
subject to the constraints
0<x<10 X+2y<4 3x-10y =14

These are constraints of the form 1 and 2.  To put the constraints into MATLAB, we need to re-write
them all in matrix form. Suppose that we store [x,y] in a vector called w. Then, we must write all our
constraints in one of 3 forms:

<w

Wi <
WSW,.
Aw <b
Cw=d

Here, W .., W, are vectors specifying the maximum and minimum allowable values of w. A and C are

constant matrices, and b and d are vectors. For our example, we would write

Wmin = Wmax =
—00 o0

A=[L 2] b=[4]
C=[3 -10] d=[14]

In our example, A, b, C, d, each had just one row — if you have many constraints, just add more rows to
all the matrices and vectors.

Now we have the information needed to write an ‘m’ file to do the minimization. Here it is:

function constrained_minimization_example
% Function to find values of x and y that minimize sin(x)*cos(y)

A=[1,2]; b=[4]; C=[3, -10]; d=[14];wmin=[0,-Inf];wmax=[10, Inf];
optimal_xy = fmincon(@(w) zofw(w),[1,2],A,b,C,d,wmin,wmax)

end

function z = zofw(w)

% w Is now a vector. We choose to make w(1l)=x, w(2)=y
x = w(l); y=w(2);
z = sin(x)*cos(y);

end

If you run this script, you’ll get the following message in the MATLAB window



>» constrained minimization example

Local minimum found that =zatisfies the conscraints.

Cptimization completed because the objective function is non-decreasing in

feasible directions, to within the default wvalue of the optimality tolerance,

and constraints are satisfied to within the default wvalue of the constraint tolerance.

<ztopping criteria details>

optimal xy =

4.2500 -0.1250

All the big words mean that MATLAB found a minimum. The values for x and y are 4.25 and -0.125.

This is just one possible minimum — there are several other local minima in this solution. You’ll find that
the solution you get is very sensitive to the initial guess for the optimal point — when you solve a problem
like this it’s well worth trying lots of initial guesses. And if you have any physical insight into what the
solution might look like, use this to come up with the best initial guess you can.

Here’s an explanation of how this script works. The constrained nonlinear optimizer is the function
fmincon(@(var)objective func(var), initguess,A,b,C,d, lowerbound,upperbound)

1.

The ‘objective_func’ specifies the function to be minimized. The solution calculated by the
function must always be a real number. It can be a function of as many (real valued) variables as
you like — the variables are specified as a vector that we will call w. In our example, the vector is
[x.y].

The ‘initial guess’ is a vector, which must provide an initial estimate for the solution w. If
possible, the initial guess should satisfy any constraints.

The arguments ‘A’ and ‘b’ are used to specify any constraints that have the form Ax <b, where
A is a matrix, and b is a vector. If there are no constraints like this you can put in blank vectors,
i.e. just type [] in place of both A and b.

The arguments C and d enforce constraints of the form Cw=d. Again, if these don’t exist in
your problem you can enter [] in place of C and d.

The lowerbound and upperbound variables enforce constraints of the form Wi, SW <Wpay,

where lowerbound is the lowest admissible value for the solution, and upperbound is the highest
admissible value for the solution.



15. Reading and writing data to/from files

MATLAB is often used to process experimental data, or to prepare data that will be used in another
program. For this purpose, you will need to read and write data from files. Learning to read and write
data is perhaps the most difficult part of learning MATLAB, and is usually a big headache in mastering
any new programming language. Don’t worry if this section looks scary — you won’t need to do any
complicated file 1/0 in this class. You could even skip this section altogether the first time you do this
tutorial, and come back to it later.

MATLAB can read a large number of different types of file, including simple text files, excel worksheets,
word documents, pdf files, and even audio and video files. We will only look at a small subset of these

here.

Comma separated value files are the simplest way to get numerical data in and out of MATLAB. For
example, try the following in the command window

>> A = pascal(5);

>> csvwrite(‘examplefilel.dat’,A);
Then open the file examplefilel.dat with a text editor (Notepad will do). You should find that the file
contains a bunch of numbers separated by commas. Each row of the matrix appears on a separate line.
You can read the file back into MATLAB using

>> B = csvread(‘examplefilel.dat);

>>B
If you are using this method to read experimental data, and need to know how much data is in the file, the
command

>>[nrows,ncols]=size(B)
will tell you how many rows and columns of data were read from the file.

Using the ‘import” wizard Simple files, such as comma-separated-value files, simple spreadsheets, audio
files, etc can often be read using the ‘import” wizard. To try this, click the ‘Import Data’ button on the
main matlab window (see below)
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and then select ‘import file’ from the popup window. The resulting window should show you what’s in
the file, and give you some options for reading it. If you then select ‘Import Selection>Import Data’, the
data in the file will be read into a matrix valued variable called ‘examplefilel’



Formatted text files: With a bit of work, you can produce more readable text files. For example, write a
MATLAB script in an M-file containing the foIIowmg lines

s = ['Now is the winter of our discontent :
'‘Made glorious summer by this son of York *;
'‘And all the clouds that lowrd upon our house';
'In the deep bosom of the ocean buried T
% Note that you have to add blanks to make the lines all the same length, or MATLAB gives an error
phone = [202,456,1414];
pop = 7354219000;
outfile = fopen("examplefile2.dat”, "wt");
fprintf(outfile,” MY FILE OF USEFUL INFORMATION \n\n®);
fprintf(outfile,” First lines of Richard 111 \n");
fprintf(outfile, " %44s \n",s(1,:),s(2,:),s(3,:),s(4,:));
fprintf(outfile, "\n Phone number for White House: ");
fprintf(outfile, "%3d %3d %4d",phone);
fprintf(outfile, "\n\n Estimated global population on Jan 1 2017 %d*,pop);
fclose(outfile);

Then run the script, open the file examplefile2.dat to see what you got. For full details of the fprintf
command you will need to consult the MATLAB manual (look under ‘Functions’ for the entry entitled
I/0). Here is a brief explanation of what these commands do.

1. The outfile=fopen(‘filename’,”wt’) command opens the file — the argument ‘wt” indicates that the
file will be opened for writing. 1f you omit the second argument, or enter ‘r’ the file will be
opened for reading.

2. The fprintf(outfile,” some text \n”) command will write some text to the file. The \n tells
MATLAB to start a new line after writing the text.

3. The fprintf(outfile,” %44s \n’, stringl, string2, ...) command writes a succession of character
strings, each 44 characters long. Each character string will be on a new line.

4. The fprintf(outfile,”%3d %3d %4d’,vector) writes a number 3 digits long, a space, another
number 3 digits long, another space, and then a number 4 digits long.

It usually takes a lot of fiddling about to get fprintf to produce a file that looks the way you want it.

To read formatted files, you can use the ‘fscanf’ command — which is essentially the reverse of fprintf.
For example, the following script would read the file you just printed back into MATLAB
infile = fopen("examplefile2.dat”,"r");
heading = fscanf(infile,” %30c",1);
play = fscanf(infile," %27c",1);
= Ffscanf(infile, " %47c \n",4);
dummy = fscanf(infile, "%30c",1);
phone = fscanf(infile,"%4d",3);
pop = fscanf(infile, " %*46¢c %d",1);
fclose(infile);
Run this script, then type
>>3
>>phone
>>pop
into the command window to verify that the variables have been read correctly.



Again, you can read the manual to find full details of the fscanf function. Briefly

1. heading = fscanf(infile," %30c”,1) reads the first line of the file — the %30c indicates
that 30 characters should be read, and the “,1” argument indicates that the read operation should
be performed once.

2. s = fscanf(infile," %47c \n",4) reads the 4 lines of the play: each lines is 47
characters (including the white space at the start of each line), and the \n indicates that each set of
47 characters is on a separate line in the file.

3. phone = fscanf(infile, "%4d",3) reads the White-house phone number, as 3 separate
entries into an array. The %4d indicates that each number is 4 digits long (the white space is
counted as a digit and ignored).

4. The pop = fFscanf(infile, "%*46c %d",1) reads the world population. The syntax
%*46¢ indicates that 46 characters should be read and then ignored —i.e. not read into a variable.

It is usually a pain to use fscanf — you have to know exactly what your input file looks like, and working
out how to read a complicated sequence of strings and numbers can be awful.

Reading files with textscan The problem with fscanf is that you need to know exactly what a file looks
like in order to read it. An alternative approach is to read a large chunk of the file, or even the whole file,
at once, into a single variable, and then write code to extract the information you need from the data. For
example, you can read the whole of ‘examplefile2.dat’ into a single variable as follows

>> infile = fopen(‘examplefile2.dat’,’r’);

>> filedata = textscan(infile,’%s’);

>> filedata{:}

(Note the curly parentheses after filedata). This reads the entire file into a variable named *filedata’. This
variable is an example of a data object called a “cell aray’ — cell arrays can contain anything: numbers,
strings, etc. In this case, every separate word or number in the file appears as a separate string in the cell
array. For example, try typing

>> filedata{1}{1}

>> filedata{1}{10}

>> filedata{1}{50}

This will display the first, 10" and 50" distinct word in the file. Another way to display the entire
contents of a cell array is

>>celldisp(filedata)

You can now extract the bits of the file that you are interested in into separate variables. For example, try
>> pop = str2znum(filedata{1}{58});

>> for n=1:3 phone(n) = str2num(filedata{1},{47+n}); end

>> pop

>> phone

Here, the ‘str2num’ function converts a string of characters into a number. (The distinction between a
string of numerical characters and a number is apparent only to computers, not to humans. But the
computers are in charge and we have to humor them).

Challenge: see if you can reconstruct the variable ‘s’ containing the Shakespeare. This is quite tricky...



16. Animations

In dynamics problems it is often fun to generate a movie or animation that illustrates the motion of the
system you are trying to model. The animations don’t always tell you anything useful, but they are
useful to kill time in a boring presentation or to impress senior management.

Making movies in MATLAB is simple — you just need to generate a sequence of plots, and display them
one frame at a time. But animations can be a bit of a chore — it can take some fiddling about to get
MATLAB to plot frames at equal time intervals, and it is tedious to draw complicated shapes — everything
needs to be built from scratch by drawing 2D or 3D polygons.

Example 1: Movie of a flying projectile: The script below makes a movie showing the path of a projectile

function trajectorymovie

% Function to make a movie of the trajectory of a projectile
close all

VO = 1; % Launch speed

theta = 75; %Launch angle

c = 0.2; % Drag coefficient

time_interval = 0.005; % time interval between movie frames
max_time = 1; % Max time of simulation.

theta = theta*pi/180; % convert theta to radians

w0 = [0;0;V0*cos(theta);VO*sin(theta)];

options = odeset("Events”,@(t,w) events(t,w));
[t vals,sol_vals] = ode45(@(t,w) odefunc(t,w,c),...
[O0:time_interval:max_time],w0,options);

for i=1:length(t_vals)
clf % Clear the frame
plot(sol_vals(:,1),sol_vals(:,2)) % Plot the trajectory as a line
hold on

% The projectile is simply a single point on an x-y plot

plot(sol _vals(i,1),sol vals(i,2),"ro", "MarkerSize",20, "MarkerFaceColor®,"r");
axis square
pause(0.1); % This waits for a short time between frames

end

end
function dydt = odefunc(t,w,c)
x = w(l); y=w(2); vx = w(3); vy = w(4);
vmag = sqrt(vx"2+vyn2);
dydt = [vx;vy;-c*vx*vmag;-9.81-c*vy*vmag];
end
function [eventvalue,stopthecalc,eventdirection] = events(t,w)
% Function to check for a special event iIn the trajectory
% In this example, we look
% Ffor the point when y(2)=0 and y(2) is decreasing.
y = w(2);
eventvalue = y;
stopthecalc = 1;
eventdirection = -1;
end



Example 2: Movie of a freely rotating rigid body The script below makes a movie showing the motion of
a rigid block, which is set spinning with some initial angular velocity. The code also can print an
animated .gif file that you can put on a webpage, use in a powerpoint presentation, or post on your
facebook page.

function tumbling block

% Function to make a movie of motion of a rigid block, with dimensions
% a = [a(1),a(2),a(3)], which has angular velocity vector omegaO

% at time t=0

% The code includes lines that can save the movie to an animated gif
% file for use e.g. on a webpage or a presentation.

a = [1,2,4]; % Dimensions of the block

omega0 = [0,1,0.1]; % Initial angular velocity of the block

time = 30; % Time of the computation

n_frames = 240; % # frames in the movie

% This creates vertices of a block aligned with x,y,z, with one

% corner at the origin

initial_vertices =
[0,0,0;a(1),0,0;a(1),a(2),0;0,a(2),0;0,0,a(3);a(1),0,a(3);a(1),a(2),a(3);0,a(

2),a(3)1;
% This loop moves the center of mass of the block to the origin
for j=1:3
initial_vertices(:,j) = initial _vertices(:,j)-a(jJ)/2;
end

face_matrix = [1,2,6,5;2,3,7,6;3,4,8,7;4,1,5,8;1,2,3,4;5,6,7,8];

% This sets up the rotation matrix at time t=0 and the angular

% velocity at time t=0 as the variables in the problem

y0 = [1;0;0;0;1;0;0;0;1;transpose(omega0(1:3))1;

% This creates the inertia matrix at time t=0 (the factor m/12 has
% been omitted as it makes no difference to the solution)

10 = [a(@)"2+a(3)"2,0,0;0,a(1)"2+a(3)"2,0;0,0,a()2+a(2)"2];

options = odeset("RelTol",0.00000001);
% Here we use ode45 in a new way. Instead of computing times and
% solution values at discrete points, we put everything about the solution
% in a variable called sol. We can use this variable to reconstruct
% the solution later.
sol = ode45(@(t,w) odefunc(t,w,10),[0,time],y0,options);
close all
count = O;
ax_length = 1.2*max(a)/2;
scrsz = get(0, "ScreenSize");
% The line below can be used to change the size of the image
% (useful if you want to reduce the size of the .gif file)
figurel = figure("Position®,[scrsz(3)/2-200 scrsz(4)/2-200 400
400], "Collor",[1 1 1D);
for i=1:n_frames
count = count + 1;
t = time*(i-1)/(n_frames-1);
y = deval(sol,t);
R= [y(1:3),y(4:6),y(7:9)1;
new_vertices = transpose(R*transpose(initial_vertices));
clf;
% axesl = axes("Parent”,figurel, "Position®,[0.3804 0.3804 0.44 0.46]);



patch("Vertices”,new_vertices, "Faces”,face matrix, "FaceVertexCdata®,hsv(6), "F

aceColor®, "flat™);
axis([-ax_length,ax_length,-ax_length,ax_length,-ax_length,ax_length])
axis off
pause(0.05)

% Uncomment the lines below to create an animated .gif file

% it (count==1)

% set(gca, "nextplot®, "replacechildren®, “visible®, "off")
% T = getframe;

% [im,map] = rgb2ind(f.cdata,256, "nodither™);

% else

% T = getframe;

% im(z,:,1,count) = rgb2ind(f.cdata,map, "nodither®);

% end

end

% Uncomment the line below to save the animated .gif file
%imwrite(im,map, "animation.gif",*DelayTime*,0, "LoopCount” , inf)

end

function dwdt = odefunc(t,w,l10)
% Function to calculate rate of change of rotation matrix
% and angular acceleration of a rigid body.
omega = [w(10:12)]; % Angular velocity
R= [w(1:3),w(4:6),w(7:9)]; %Current rotation matrix
I = R*10*transpose(R); %Current inertia matrix
alpha = -I\(cross(omega, I*omega)); % Angular accel
% Next line computes the spin matrix
S = [0,-omega(3),omega(2);omega(3),0,-omega(l);-omega(2),omega(l),0];

Rdot = S*R; % Rate of change of rotation matrix dR/dt
dwdt(1:9) = Rdot(1:9); %Columns of dR/dt arranged in sequence in dydt
dwdt(10:12) = alpha;
dwdt = transpose(dwdt); %make dydt a column vector
end

COPYRIGHT NOTICE: This tutorial is intended for the use of students at Brown University. You
are welcome to use the tutorial for your own self-study, but please seek the author’s permission
before using it for other purposes.

A.F. Bower

School of Engineering
Brown University
December 2016
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